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LBZ/LMM DSP2 & DSP5 Custom Operating System Tutorial EFILive V7 Tuning Tool

Important – Please Read First

The Custom Operating Systems supplied by EFILive are provided “as is” 
without warranty of any kind. Please take all reasonable caution when using 

the extended features of EFILive’s Custom Operating Systems.
This tutorial assumes you are running the software and firmware releases (or later) 
listed below.

• EFILive Scan and Tune V7.5.6.99 

• EFILive Black Box Logging and Reading V8.1.2.75 

• FlashScan/AutoCal Firmware V2.06.16 (Oct 02, 2009) 
• LBZ .calz file dates V7.23 (October 03, 2009)

Please ensure you are running the latest software & firmware. Free updates can 
be downloaded from http://www.efilive.com/
To obtain the version number of the tuning software, go to the Help > About menu 
option. You must have V7.5.6 build 99 or higher. Here you can also check the V2 
firmware version under 'FlashScan V2 VIN licensing'.
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What is EFILive DSP?

EFILive DSP (Duramax Switchable Performance) ECM (Engine Control Module) 
operating systems are modified versions of the factory ECM operating systems 
that give users the ability to use the factory ECM to perform functions beyond what 
was offered from the factory.
DSP2 is a customized ECM operating system developed by EFILive for the entire 
Duramax Diesel engine range, this document only applies to the LBZ & LMM.
DSP2 lets you switch on the fly between two user programmable tunes; DSP2 
does this by allowing you to create two versions of the main operating maps that 
control engine performance. 
DSP5 is similar to DSP2 except we expanded the number of switchable tunes 
from two positions to five. 
The LBZ / LMM DSP programs are currently only available to be switched via a 
hardwired switch, not via the V2 control unit as the LB7 / LLY DSP programs can.
Please follow the steps on the following pages to successfully upgrade your 
Duramax ECM to DSP.
You may return your ECM to its GM factory condition at any time, by reflashing a 
stock GM Operating System and calibration over the top of any EFILive Custom 
Operating System using the Full reflash option.
On the LMM ECM the CVN changes to the ECM's Operating System will be 
logged by the ECM and be will visible by the TechII diagnostic tool.
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Time to upgrade the ECM to DSP

Using the EFILive Tune Tool program you can either open the file to be converted 
to DSP off your computer hard drive, or read the tune from the ECM (on the 
vehicle or using a bench harness).

Read ECM icon:

 

Select either LBZ or LMM ECM Type:

Once the file has been read from the ECM you should save this as the stock file in 
case you need to return the ECM back to standard.
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With the tun file now in the editor, you need to click on the Tab that says - 
“Upgrade O.S”. An LBZ DSP5 upgrade will be the example used below.

Select which operating system upgrade you wish to apply (only choose one), then 
click the “Apply Upgrade” button.

VERY IMPORTANT: Only choose one DSP option and only click 
the Apply Upgrade button once.
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Now save the file with a new name, File > Save As. Maybe something like 
‘Toms Base DSP5 Conversion’
Or often some people might save the file base with the VIN like so 
‘1GCHK23123F123456 Base DSP5 Conversion’

Once the file has been saved with its new name you now need to close the file 
down, File > Close Tuning File.
Now you need to reopen the file so EFILive will recognise the file is a DSP 
converted operating system, please also take note of the new operating system 
number of the DSP converted file (circled in red below).
DSP2 will become 2xxxxxxx (eg 12606128 to 22606128)
DSP5 will become 5xxxxxxx (eg 12606128 to 52606128)

EFILive automatically populates the new DSP tables with factory maps during the 
upgrade to get you started. On modified engines these may not be suitable 
settings, you may need to copy your own tables in to the new DSP section(s).
This upgraded *.tun file will become your “base calibration” for the upgraded 
Operating System. Always keep a copy of this file incase you need to restore your 
ECM to its initial Custom Operating System state. Preferably, make a backup of it 
onto a CD or USB memory stick and store it in a safe place or Email it to a friend.
The final step is to now do an entire ECM reflash with the new DSP operating 
system and calibrations.  This is covered on the next page.
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Hints for in-vehicle ECM flashing: 
• Ensure your vehicle is keyed to ON (not Accy), without the engine running.

• Ensure the battery is in a good state of charge.

You will need to perform a ‘Full Reflash’ of your ECM to use the newly created 
DSP operating system and calibrations. Once this completes successfully you will 
only need to do ‘Calibration’ flashing for normal tuning procedures.
The EFILive Tuning Tool manual covers reflashing procedures, it is highly 
recommended you also refer to that document whilst performing this programming 
procedure as this covers the correct steps for performing the full ECM flash and 
how to go about ECM recovery should something go wrong.
With your DSP file loaded press the button circled in the picture below.

Once the full flashing procedure finishes (approx 8 -11 minutes depending on the 
ECM type), turn off the IGN for at least 30 seconds to allow all the vehicle modules 
to fully shut down.
Next, start the truck and ensure everything is running and operating correctly (A/C, 
cruise control, etc).
Once these tests are complete you can wire up your DSP switch. Once that is 
complete you can start tuning your DSP programs. Without the DSP switch wired 
up the ECM will still be running off the factory maps.
It is highly recommended that you disconnect the trucks battery before attempting 
any wiring modifications.

Please Note: Once the DSP OS is flashed in to your ECM you will no longer be 
able to read the tune back out of the ECM, so please ensure you keep a copy of 
your tunes safe.

support@efilive.com - 8 - www.efilive.com



LBZ/LMM DSP2 & DSP5 Custom Operating System Tutorial EFILive V7 Tuning Tool

Wiring the DSP2 Switch

The DSP2 switch works by switching the voltage level at an ECM pin to 0V (ground). 
The ECM monitors the voltage to determine which program you wish to run.
When the switch is open, the ECM will use the factory maps, when the switch is closed 
(grounded) the ECM will use the DSP2 tables.

The connections to the ECM from the switch are made to the following pins –

LBZ & LMM
Signal = Connector 1 (the larger plug), pin 52 , (next to LtBlue/Black wire).
Ground = Connector 1 (the larger plug),  pin 54, (next to Yellow/Black wire).
Note: It may also be possible to make the ground connection in the cab rather than the ECM.

(Also see the connector view below for reference)
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Wiring the DSP5 Switch

The DSP5 switch works by selecting different voltages for the ECM to measure, from 
these voltages the ECM can determine which program you wish to run.
Below is the suggested resistance to be used for any DSP5 switch you may wish to 
design. Also shown is the approx voltage the ECM will measure for each resistance. 
The switching voltages are configurable within EFILive, however, the values below give 
a good even separation of switch points.
The 0.1uF capacitor shown in red is optional, it is used to reduce switch bounce.

The connections to the ECM from the switch are made to the following pins –

LBZ & LMM
Signal = Connector 1 (the larger plug), pin 46, (next to Grey wire-LBZ,Tan wire-LMM).
Ground = Connector 1 (the larger plug),  pin 54, (next to Yellow/Black wire).
Note: It may also be possible to make the ground connection in the cab rather than the ECM.

(Refer to the connector view on the previous page)

The part number for the connector pins is – Tray #19, 1928498135
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LBZ / LMM ECM Connector wiring installation
#1 – Locate ECM Plug #2 – Remove the Larger Plug

#3 – Remove purple locking clip 
(don't loose it!!)

#4 – Remove top cover

#5 – Insert new pins/wires
Reverse procedures once done.

Pin-out Reference (viewed looking at 
connector bottom). 

Joe Harden has provided an in-depth install guide at the end of this document
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Important DSP5 Parameters and Tables

A9136, A9236, A9336, A9436 – DSP5 switching voltages
These parameters set up the switching points for each DSP program to become 
enabled.
It works by the voltage from the switch for each tune needing to fall between each 
adjacent parameter for a valid reading. So as an example only, if you set the 
parameters like so –
A9136 (DSP Program #1) = 4.00V
A9236 (DSP Program #2) = 3.00V
A9336 (DSP Program #3) = 2.50V
A9436 (DSP Program #4) = 1.80V
For the non DSP Program (stock) to become enabled the switch voltage must be above 4.01V.

For DSP Program #1 to become enabled the switch voltage must be between 4.00V and 3.01V.

For DSP Program #2 to become enabled the switch voltage must be between 3.00V and 2.51V.

For DSP Program #3 to become enabled the switch voltage must be between 2.50V and 1.81V.

For DSP Program #4 to become enabled the switch voltage must be between 0.00V and 1.80V. 

Check with your DSP5 switch provider for the correct settings.

Monitoring DSP status in the Scantool
You can monitor the DSP switch data using the following PID’s –
GM.E35DSP2_DMA (PC) or E35DSP2_M (BBL):
This PID will show if the DSP2 tune is enabled.

GM.E35DSP5_DMA (PC) or E35DSP5_M (BBL):
This PID will show the current tune number the ECM is using for DSP5.

GM.E35DSP5V_DMA (PC) or E35DSP5V_M (BBL):
This will show the measured voltage at the ECM pin when using DSP5, useful for 
setting up the DSP5 switching voltages, otherwise just use the previous PID to monitor 
the DSP program switching.

support@efilive.com - 12 - www.efilive.com



LBZ / LMM – DSP5 pin install guide 
Contributed by EFILive beta tester, Joe Harden

I’m not sure if it makes it easier for the install, but I removed the driver’s side inner fender.

Use the “throttle cable” port through the firewall as a way to route the wire from the switch 
to the ECM.  (note that EGT and boost wires are already installed though this port in the 
pictures)



Press the grommet into the cab

 
This is an under-dash view of what’s taking place.



Pop the rubber center out of the grommet.  (It’s been a while since the egt / boost install 
was done, but it seems like I had to make a cut into the rubber center in order to remove it 
from the “throttle cable”.  It already had a slit in it during this install, but I don’t remember if 
I did it earlier or not.)

Now that the center is out, the grommet can be pulled through the firewall (into the engine 
bay) where it is easier to feed the wire through it.  I had the pin soldered to the wire, since I 
don’t have the proper crimping tool.  The crimping tabs on the pin need to be trimmed 
down and the solder can’t be very thick, since the whole pin needs to fit down a hole about 
the size of the head of the pin.)



The grommet can be installed back into the firewall after the wire is fed through.

Location of ECM



At this point, the batteries need to be disconnected! 
Locate the ratcheting lever on the lower connection of the ECM and pull upward (toward 
the sky).  As the lever rotates upward, the plug will back out of the ECM.  Assist the ratchet 
in backing out the connector.  The ratchet will stop after about 90° of rotation from the 
starting position.

This connection is referred to as C2 of the ECM.  (We’re interested in C1 above it, but C2 
needed to be removed in order to make C1 available.)
Now remove connector C1 (directly above C2).  The same ratcheting lever is on this 
connector as C2, except the lever needs to be pulled down (toward the ground).



Here’s C1 after being unplugged from the ECM.

There’s a pink clip in the connector that holds the pins in place.  This needs to be 
removed.  I used a small allen-wrench to get down in the notch of the pink clip and applied 
pressure to the end of the connector to remove it.



Remove it completely from the connector.

Next, take the ratcheting mechanism / cover off the connector.  First, pop up the end 
nearest the wire bundle.





The pin is to be inserted in location 46 (from this view with the wire bundle on the right side 
of the connector, it’s the 3rd slot in from the beginning of the second row.  If confused, 
follow the red wire across the picture.)

Referring to this view, the pin needs to be oriented such that the wider side of the head of 
the pin is closest to location 47 (grey wire).
It is a good idea to have a small piece of rigid wire (or a straightened out paper-clip) near 
by to help push the pin into location.
Reinstall the pink clip and make sure everything is where it needs to be.  If the clip won’t 
slide completely through the connector, especially if it stops in the area of the new pin, 
then check that the pin has been seated in the connector with the rigid wire.
Once the pink clip is in place, press the sliding portion of the ratcheting mechanism back 
into the connector and attach the ratchet lever / cover back onto the connector (the lever is 
to be down in the “locked” position when this is carried out.)  Having the slide pushed in 
and the lever down properly position the gear and slide.
C1 is now ready to be connected to the ECM, so pull the lever back to the fully open 
position and insert the connector into the top port until you feel the slide mechanism make 
contact with the ECM.  Now begin pushing the lever up while helping the ratchet feed the 
connector into the port.
C2 can now be reinstalled into the lower port.  Having the lever in the full open position, 
follow the same steps as C1, except the lever will be pulled toward the ground while the 
connector is being guided into the port.
The batteries can now be reconnected and the inner fender can be reinstalled.
This install didn’t include a ground wire from the switch to the ECM.  I currently have the 
switch grounded to the metal support under the steering column, and it works fine.
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